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Description
The DX4104 Series digital video recorder (DVR) is designed for the entry-level market. The unit provides one to four camera inputs, powerful 
video storage management with efficient H.264 compression, multi-event recording, a quick and easy-to-use common user interface, internal 
storage up to 2 TB, and network connectivity features. The DX4104 replaces the traditional VCR and multiplexer combination and can be used in 
stand-alone or networked installations.

The DX4104 is easily operated and configured using the mouse, remote control, or front panel. User-configurable disk partitioning is used to 
allocate specific hard disk space for storing normal (continuous) and event-initiated video data. The retention time can be different for normal 
and event-initiated recorded video. All recorded video is compressed and stored using the latest H.264 compression technology. 

The DVR supports single-event and multi-event (a combination of normal, alarm, and motion) recording. You can immediately start and stop 
recording through the instant record feature. Each camera can be configured to record at a resolution, quality, and image rate specific to each 
event. By default, the DX4104 is configured for automated multi-event recording. 

For surveillance applications requiring pan/tilt/zoom (PTZ) capability, the DX4104 addresses and controls PTZ equipment such as Spectra® 
domes, mini domes, or third-party cameras. The unit operates Pelco and third-party PTZ cameras that support Pelco D and Pelco P protocols. 

Video critical to investigation and archiving can be exported from the DX4104 server, to USB memory, or an optional CD/DVD±RW device. Use the 
exported video preview feature to verify the video content and quality. 

The DX4104 remote client can be used to remotely operate and administer the unit. The remote client includes an export viewer, Web client, and 
emergency agent application. You can play back exported video using the export viewer or a Microsoft® Windows®-based media player 
application. 

The DX4104 remote client is Vista-compliant. At the remote client, users can easily and quickly capture a video scene, save it in JPEG format, and 
then store it on the hard drive. Additionally, the remote client can be used to preview and search backed up video. The DX4104 remote client also 
allows live viewing and video playback from up to 16 DX4104 units simultaneously. The remote client can connect to as many as 100 DX4104 
units.

CLIENT APPLICATION SOFTWARE
DX4104 software runs on two platforms:

• The DX4104 server software runs on the DX4104 Series DVR. 

• The DX4104 client application software runs on a personal computer (PC) and allows you to log on to and operate the DX4104 server 
system from your local PC. 

Fully implemented networking capabilities allow remote viewing of live video, playback, and administration of DVR server features. Versatile 
high-speed search operations include time and date, bookmark, event, and pixel searching. Extensive scheduling features allow customizing of 
day, weekday, weekend, and special event recording. The DX4104 provides a graphical user interface (GUI), allowing for quick and efficient 
access to setup and operating features.

DX4104 supports four software applications that run on a PC: 

• Remote Client software application: Allows you to log on to, operate, and administer up to 16 DX4104 units. The DX4104 supports a 
total of five simultaneous connections when using the client and Web client applications. For more information about the remote client 
software application, refer to the DX4104 Client Operation/Configuration manual. 

• Export Viewer: Allows you to view exported video. It is designed to recognize and verify the digital watermark that is embedded in the 
Pelco-engineered *.exp video format for DX4104.

• Emergency Agent: Works with networked DX4104 units to alert users when one or more channels detect an alarm, motion, or video loss 
event. The emergency agent runs on a networked client PC. 

• Web Client: Allows you to view live video and operate PTZ features of cameras attached to a DX4104.
C4632M (11/09) 9
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Important Notice

VIDEO QUALITY CAUTION

FRAME RATE NOTICE REGARDING USER-SELECTED OPTIONS

Pelco systems are capable of providing high quality video for both live viewing and playback.  However, the systems can be used in lower quality 
modes, which can degrade picture quality, to allow for a slower rate of data transfer and to reduce the amount of video data stored.  The picture 
quality can be degraded by either lowering the resolution, reducing the picture rate, or both.  A picture degraded by having a reduced resolution 
may result in an image that is less clear or even indiscernible.  A picture degraded by reducing the picture rate has fewer frames per second, 
which can result in images that appear to jump or move more quickly than normal during playback.  Lower frame rates may result in a key event 
not being recorded by the system.

Judgment as to the suitability of the products for users’ purposes is solely the users’ responsibility. Users shall determine the suitability of the 
products for their own intended application, picture rate and picture quality.  In the event users intend to use the video for evidentiary purposes 
in a judicial proceeding or otherwise, users should consult with their attorney regarding any particular requirements for such use.
10 C4632M (11/09)
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Product Overview

CLIENT APPLICATION WINDOW

Figure 1. Client Application Window

ì Site Tree: Displays top-down, hierarchical management of DX4104 resources, such as servers, cameras, alarms, and relays.

î Toolbar: Provides buttons for quick access to Live, Search, Setup, Export, Print, screen display options, Full Screen, and Connection List 
Setup. 

ï Title Bar: Displays the application title.

ñ Menu Bar: Provides access to commands.

ó View Panels: Panel: Displays as many as 16 panes for viewing live and playback video. Each pane displays video for a single camera 
channel. For additional information about view panels and panes, refer to Navigating View Panes on page 25 for more information.

r PTZ Control Panel: Allows users to operate cameras that support PTZ features. 

s PTZ On-Screen Display (OSD) Menu: Allows users to operate PTZ OSD features. Refer to PTZ Controls on page 30 for more 
information. 

t Playback Control Panel: Allows users with administrator- or power-level permissions to control video playback. Includes playback 
controls, playback speed, and volume. 

u Playback Timeline: Displays a 24-hour timeline marked with color-coded video events. Allows users with administrator- or power-level 
permissions to select a date and time for playback. 

~í Status Bar: Displays current date and time and the permission level of the logged on user. 
C4632M (11/09) 11
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MENU BAR
The DX4104 Menu bar allows you to access the File, View, and Help menu features. The following tables describe the menu commands. 

FILE MENU

VIEW MENU

HELP MENU

Table A. File Menu

Command Description

Connect Establish connection between the Client application and DX4104 server.

Disconnect Disconnects the Client from the site and discontinues displaying video from the disconnected site.

Save to JPEG Allows you to save a screen shot in JPEG format to a designated location on the PC hard drive. The default location 
is C:\DX4100 Exported files. 

Backup Search Allows you to search backed up video stored on a media device.

End Backup Search Ends the backup search mode.

Exit Exits the Client application.

Table B. View Menu 

Command Description

OSD Opens the on-screen display (OSD) submenu with the following global display options.

• Channel Number: Displays the input channel (01 to 04) to which the camera is connected. 

• Site Name: Displays the site name.

• Camera Name: Displays the camera name.  The default name is CH 01 to CH 02.

• Playback Time: Displays the date and time that the video was recorded. 

• PTZ: Displays the PTZ controls for each channel configured for PTZ operation.

• Audio: Displays the Audio controls for each channel assigned to an audio input.

• Select All: Selects all of the OSD options.

Cycle View (Dwell Time) Opens the dwell time submenu.

Language Opens the language submenu. 

HDD Information Opens the HDD Information dialog box that displays the normal and event partition storage capacity status. 

Log View Displays system events that have occurred on the date selected in the Date box.

Table C. Help Menu

Command Description

DX Client Information Provides model and version information about the Client application.
12 C4632M (11/09)
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GUI TOOLBAR
Table D. GUI Toolbar Features and Functions

Live: Displays the main application window.

Search: Opens the Search window. 

Setup: Opens the Setup window.

Export: Opens the Export dialog box.

Print: Opens the Print dialog box.

1-Division: Displays video from one camera.

4-Division: Displays video from four cameras (2 x 2).

9-Division: Displays video from nine cameras (3 x 3).

16-Division: Displays video from sixteen cameras (4 x 4).

6-Division: Displays video in one large pane and five smaller images (1 large and 5 small).

8-Division: Displays video in one large pane and seven smaller images (1 large and 7 small). 

Cycle View: Starts and stops the window cycling display. 

Full Screen: Hides the GUI controls and displays video on the entire screen. Click the right mouse button to exit the full-screen 
view. 

Connection List Setup: Opens the Connection List dialog box. Use this dialog box to add, change, and delete a site.
C4632M (11/09) 13
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VIEW PANES AND PANELS
The DX4104 Client view panel is organized into panes. Video from each camera appears in its own view pane. 

Figure 2. View Panes and View Panel

ì View Panel: Displays video in 1 to 16 panes.

î View Pane: Displays video from a single camera.
14 C4632M (11/09)
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SITE TREE
The Site Tree provides access to remote site resources (cameras and alarm inputs). To select a camera from the site tree, drag a camera to a 
pane. The Site Tree information reflects the current remote server configuration.

Figure 3. Site Tree

ì Remote Site Location: Expands and collapses the remote site. Right-clicking the site name opens a shortcut menu containing 
the following commands:
• User Log-In: Opens the Remote Login dialog box.

• User Log-Out: Logs you off of the remote site.

• Connect: Connects the Client application to the remote site.

• Disconnect: Disconnects the Client application from the remote site. 

î  List of Cameras: Expands and collapses the Camera tree.

ï  Camera Name: Expands and collapses the camera settings. 

ñ Camera Configuration Settings:

• Resolution

• Frame rate

• Image quality

• Recording mode

• Relay output 

• Audio input 

ó  Alarm In: Expands and collapses the Alarm In tree. Expand an alarm input to see the relay out and camera assignment.
C4632M (11/09) 15
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PTZ CONTROL
The PTZ control can be used to operate and configure cameras that have been configured for PTZ operation, including those that support Pelco P 
and Pelco D protocols and third-party dome cameras.

Figure 4. PTZ Control

ZOOM: Zooms the camera in and out.

FOCUS: Performs two functions:

• In PTZ mode: Adjusts the camera focus.

• In camera menu: FOCUS+ and FOCUS- is used to navigating up and down the camera menu choices.

IRIS: Performs two functions:
• In PTZ mode: Opens and closes the camera iris.
• In camera menu: IRIS plus (+) selects an item. IRIS minus (-) exits an option setting.  In the menu, the IRIS button 

moves the cursor to EXIT.

Keypad: Use the keypad to enter presets or pattern numbers.

Program: Accesses the camera programming mode.

Clear: Deletes a programmed preset, pattern, or tour.

PRESET: Performs three functions:
• In preset programming mode: Stores the preset in the selected memory location. 
• In PTZ mode: Activates a preset.
• Tour: Starts a a preset tour. 

PATTERN: Performs two functions:
• Pattern programming mode: Stores the pattern in the selected memory location. 
• PTZ mode: Activates a pattern.

Auxiliary: Unsupported at this time.

SET: Performs two functions:
• Enters PTZ programming mode.
• Exits PTZ programming mode.

PGM

CLR

PRESET

PATTERN

AUX

SET
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Figure 5. PTZ OSD Menu Control

ì Enter: (Third-party cameras only) Provides the following actions:
• Displays the selected remote camera OSD menu for PTZ cameras.
• Accepts the selected remote camera OSD menu choice.
• Accesses menu option parameters. 

î Exit: (Third-party cameras only) Exits the camera menu. 

ï Up and Down Arrows: Move the camera, navigate through the remote camera OSD menu, and cycle through a list of options or 
parameters.

ñ Left and Right Arrows: Move the camera.

��

�

�
�
�
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LIVE ON-SCREEN DISPLAY
The live on-screen display (OSD) consists of superimposed camera and site information. Each item in the OSD can be displayed or hidden. The 
OSD settings apply for all channels.

Figure 6. Live OSD Pane

ì PTZ : Indicates that the PTZ control is enabled.

î Audio: Indicates that audio recording is enabled. The DX4104 compresses audio data to save space. In this case, recorded audio may not 
be of the same quality as live audio. 

ï Recording: Indicates the camera recording mode and status. 

 No Record: Live video is displayed but not record video.

 Normal Record: Video is continuously recorded. 

 Alarm Record: Only video associated with an alarm event is recorded.

 Motion Record: Only video associated with a motion event is recorded.

 Instant Recording: Indicates that the instant recording mode is active.

ñ On-Screen PTZ Control: Facilitates mouse control of PTZ functions. Refer to PTZ Mode on page 30 for more information. 

ó Channel Number and Camera Name: Displays the channel input (BNC) and the camera name. 

r Site Name: Displays the created site name. 

N

A

M

I
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PLAYBACK CONTROLS
The playback controls start playback, control direction, and adjust speed. Click Stop at any time to return to the Live mode. 

PLAYBACK

Figure 7. Playback Controls

ì Frame-By-Frame Reverse: Each frame is displayed in the reverse direction by continually clicking the button.

î Frame-By-Frame Forward: Each frame is displayed in the forward direction by continually clicking the button.

ï End of Video: Advances the bookmark to the end of the latest recorded video. 

ñ Forward Playback: Initiates normal playback of recorded video in the forward direction.

ó Stop: Stops playback control activity and returns to the Live mode.

r Pause: Pauses video playback.

s Reverse Playback: Initiates normal playback of recorded video in the reverse direction.

t Beginning of Video: Returns the bookmark to the beginning of the earliest recorded video. 

� �

� �

�
�

�
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PLAYBACK SPEED AND VOLUME

Figure 8. Playback Speed and Volume Controls

ì Normal: Plays back video at normal speed.

î Faster: Plays back video at a faster rate than normal speed.

ï Slower: Plays back video at a slower rate than normal speed.

ñ Volume: Increases or decreases the volume of played back video.

ó Audio: Activates or silences the audio output of played back video.

�
��

�

�
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PLAYBACK TIMELINE
Use the timeline to select the date and time to begin playback. Time periods containing recorded video are represented as color-coded segments 
of the timeline. The timeline includes a horizontal pointer that shows the time in 1-hour segments. The pointer is positioned within the timeline 
by using the hour, minute, and seconds boxes to select playback time in 24-hour period. While in Live mode, you can drag the timeline pointer 
into the timeline. The scroll bar allows you to position the timeline within a 24-hour period.

Figure 9. Playback Timeline

ì Select All: Allows all channels to be played back simultaneously.

î Camera Number: Displays the selected camera name and number. 

ï Remote Site: Displays the selected site name.

ñ Date Box:  Opens the calendar.

ó Time Box: Allows you to select the playback or search time in a 24-hour period (hour, minute, and seconds).

r Increase Detail: Allows you to expand the time scale to view smaller increments of time.

s Decrease Detail: Allows you to decrease the time scale to view larger increments of time.

t Alarm Recording: Displays alarm event video in red.

u Motion Detection Recording: Displays motion event video in blue.

~í Normal/Instant Recording: Displays normal and instant video in green.

~â Pointer: Provides a visible time indicator within the recorded data displayed in the timeline.

~ä Scroll Bar: Allows you to scroll through the timeline.
C4632M (11/09) 21
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Operation

STARTING AND LOGGING ON TO A SITE
To start and log on to the Client application, perform one of the following options:

• Site Tree is not configured with DX4104 servers: When the Client application starts for the first time, DX4104 server sites are not 
configured to appear in the Site Tree. 

To start the Client application for the first time and add servers to the Site Tree, refer to Starting the Client for the First Time on page 22 for 
more information.

• Site Tree is configured with DX4104 servers: To start the Client application, refer to Starting and Logging On to a Site on page 22 for 
more information.

• Administering sites: To administer an existing site, refer to Administering Sites in the Site Tree on page 24 for more information.

STARTING THE CLIENT FOR THE FIRST TIME

1. On the task bar, click Start, All Programs, Pelco, Pelco DX4100 Client, and then click DX4100 Client. The DX4100 Client Password dialog box 
appears. 

2. Type the default Client password 000000 (six zeros) and click OK. The Client window and the Connection List dialog box appear. By default, 
the Client window opens in a 16-Division display. 

Figure 10. Starting the Client for the First Time
22 C4632M (11/09)
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3. To create a site:
a. In the Connection List dialog box, click Add. The Connection Setup dialog box appears.

b. In the Site Name box, type a site name.

NOTE: Using special characters in the site name other than those listed below will cause the export process to fail. 

• Characters can include letters (a to z, upper and lowercase), numerals (0 to 9), 
and special characters `, ~, !, @, #, $, &, ( ), -, _, =, +, [ ], ., and { }.

• A site name must not exceed 18 characters in length. 

c. In the IP Address box, type the server IP address.

d. (Optional) By default, the Client application uses port 9001 for communicating with DVR servers. Before you change a port number:

• Consult your network administrator. 

• Make sure that the ports are not blocked internally and are protected from external threats by a firewall. Client and server ports 
must be identical.

e. Click OK. The server site appears in the Connection List.

f. Repeat steps 3a to 3e to create additional sites.

4. Click OK. The DVR sites appear in the Site Tree.

5. To connect to and log on to a site:
a. In the Site Tree, right-click a site. The shortcut menu appears.

b. Click Connect. Video from the site is displayed in the Client window.

c. Right-click the site again. 

d. Click User Log-in. The Remote Login dialog box appears.

e. In the User ID box, type your user name.

f. In the Password box, type your password.

To log off or disconnect from a site, refer to Logging Off on page 24.

STARTING THE CLIENT AND LOGGING ON TO A SITE

To start the client and log on to a site:

1. On the task bar, click Start, All Programs, Pelco, Pelco DX4100 Client, and then click DX4100 Client. The DX4100 Client Password dialog box 
appears. 

2. In the Password box, type the default Client password 000000 (six zeros).

3. Click OK. The Client window appears.

4. To connect to and log on to a site:
a. In the Site Tree, right-click a site. The shortcut menu appears.

b. Click Connect. Video from the site is displayed in the Client window.

c. Right-click the site again. 

d. Click User Log-in. The Remote Login dialog box appears.

e. In the User ID box, type your user name.

f. In the Password box, type your password.

g. Click OK.

To log off or disconnect from a site, refer to Logging Off on page 24.
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LOGGING OFF
To log off from a DX4104 remote site:

1. In the Site Tree, right-click a remote site. The shortcut menu appears.

2. Click User Log-Out. The system logs you off and Guest is displayed in the status bar.

END A SERVER CONNECTION
To end a server connection:

1. In the Site Tree, right-click a remote site. The Site Tree submenu appears.

2. Click Disconnect. The Client application is disconnected from the remote site, the Pelco logo appears, and Log Out is displayed in the status 
bar. 

ADMINISTERING SITES IN THE SITE TREE

CHANGING A SITE
1. On the toolbar, click the Connection List icon . 

2. In the Connection List, click a remote site.

3. Click Edit. The Connection Setup dialog box appears.
a. Click a settings box and type the updated setting. 

b. Repeat step 3a for additional settings.

c. Click OK. 

DELETING A SITE

NOTE: Once a site is deleted from the Site, it cannot be restored.

1. On the toolbar, click the Connection List icon . 

2. In the Connection List, select a remote site.

3. Click Delete. The remote site is removed from the table, but it is not deleted from the Site Tree.

4. Perform one of the following options:

• Complete the deletion: Click OK. The remote site is deleted from the Site Tree.

• Cancel the deletion: Click Cancel. The remote site is not deleted.
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CLIENT OPERATING MODES
The DX4104 Series DVR has four primary operating modes: Live, Playback, Search, and Export. Refer to Product Overview on page 11 for more 
information.
 

LIVE VIDEO
By default, the unit comes ready to view and record live video. 

Figure 11. Client Application Window

NAVIGATING VIEW PANES

1. On the toolbar, click a display option. 

Figure 12. Toolbar Display Buttons

2. Click a pane to make it active. A red border highlights the pane.

Table E. Client Operating Modes

Live and Playback Modes:
• Live: Allows all users to view live video.
• Playback: Allows users with administrator- or power-level permissions to play back recorded video. 

Search Mode:  Allows users with administrator- or power-level permission to search video data using specific criteria. 

Export Mode:  Allows users with administrator- or power-level permissions to export video and audio from a DVR server. Users can 
also specify the media and location for storing the exported data.
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ASSIGNING CAMERAS TO VIEW PANES
In the Site Tree, click and drag individual cameras to a view pane. Repeat the process for up to 16 cameras. 

In the Site Tree, click and drag Cameras to a pane. All cameras in the Site Tree are assigned sequentially to the panes.

NOTE: If you do not want a camera to be viewed, you must replace the camera with another one from a different remote site. If you have only 
one remote site, you cannot remove a camera from a pane.

LIVE MODE

CUSTOMIZING THE ON-SCREEN DISPLAY
By default, all of the OSD options are selected. The Client application allows you to customize the OSD settings. These settings apply globally for 
all panes and remote sites. 

1. On the View menu, point to OSD. The OSD submenu appears. 

Figure 13. Client OSD Menu Options

2. Either select or clear an OSD option.

3. Repeat steps 1 and 2 to customize each display feature.

SEQUENCE DWELL TIME
Set the sequence dwell time to meet your security application requirements. Once you configure the dwell time, you have to manually start the 
sequence mode. The sequence dwell time has the following guidelines:

• Channel/cameras are sequenced in the order that they are assigned to panes.

• Channel/cameras are organized by groups: 
– Group 1, channels 1 to 4
– Group 2, channels 5 to 8
– Group 3, channels 9 to 12
– Group 4, channels 13 to 16

• Groups are sequenced if video is displayed on at least one of the four channels in a group. Video from the active channel is displayed and 
the Video Loss message or the Pelco logo displays in the application window for all remaining channels in the group. If no video is 
displayed for any of the channels in a group, either Video Loss or the Pelco logo displays in the application window.
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Selecting the Sequence Dwell Time

1. On the View menu, point to Cycle View (Dwell Time), and then click a setting.

Figure 14. Setting Sequence Dwell Time

2. On the toolbar, click display option.

Starting and stopping the Sequence View

On the toolbar, click the Cycle View icon . The icon changes color and the cycle process either starts or stops.

FULL-SCREEN DISPLAY
The Client application allows you to display video across the entire screen. In this view, the GUI controls are not displayed.

On the toolbar, click the Full Screen Display icon . The video panes are displayed in the application window (refer to Figure 15).

Right-click in the application to return to the standard application window.

Figure 15. Full-Screen Display
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SELECTING A LANGUAGE
The Client application allows you to choose the display language for menus and dialog boxes. By default, the display language is English. You 
must restart the Client application for the new setting to take effect.

1. On the View menu, click a language option. The DX4104 Client dialog box appears.

Figure 16. Selecting a Language

2. Click OK, and then click Close. 

3. Restart the Client application. 

VIEWING HDD INFORMATION
The HDD Information dialog box displays data about DX4104 server storage capacity (refer to Figure 17). The HDD space allocated to the normal 
and event partition is configured on the DX4104 server using the Hard Disk option on the System menu. HDD overwrite and full-warning options 
can be configured from the Client application. 

On the View menu, click HDD Information. The HDD Information dialog box appears.

Figure 17. HDD Information Dialog Box
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VIEWING THE SYSTEM LOG
The DX4104 server monitors specific system-related events and stores that information in a log file, which can be viewed from the Client 
application. Table F describes the system-related events.

1. On the View menu, click Log View. The Log View dialog box appears.

2. In the Date box, click a date. 

3. Click Search. The search results appear. 

Figure 18. System Log Search Results

4. In the Scroll box, click the arrow buttons to view events on the current, previous, or next page.

Table F. System Log Events

Admin Login (Local) Configuration Imported HDD Damaged (HDD3) HDD Removed (HDD3)

Admin Login (Remote) Export Failed HDD Damaged (HDD4) HDD Removed (HDD4)

Admin Logout (Local) Export Finished HDD Formatted (HDD1) Normal User Login (Local)

Admin Logout (Remote) Export Started HDD Formatted (HDD2) Normal User Login (Remote)

Backup Failed Factory Default Set HDD Formatted (HDD3) Normal User Logout (Local)

Backup Finished Guest Login (Remote) HDD Formatted (HDD4) Normal User Logout (Remote)

Backup Started Guest Logout (Remote) HDD Removed (HDD1)

Configuration Changed HDD Damaged (HDD2) HDD Removed (HDD2)
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PTZ MODE
All user levels have access to the PTZ controls to operate and program cameras. PTZ functions can be controlled on the screen in live mode using 
the mouse. The PTZ control can be used to operate and configure cameras that have been configured for PTZ operation, including those that 
support Pelco P and Pelco D protocols and third-party dome cameras. Refer to the DX4104 Installation manual and the DX4104 Server Operation/
Configuration manual for more information. Each input channel for a PTZ camera must be configured for PTZ operation before the controls can be 
used. Refer to PTZ Mode on page 54 for more information. 

PTZ CONTROLS

1. On the toolbar, click the Live icon .

2. On the View menu, point to OSD, and verify that PTZ is selected.

3. In the Client window, click a pane that displays PTZ . 

4. Place the mouse pointer in the middle of the pane. The mouse pointer changes to a cross.

Figure 19. On-Screen PTZ Control

5. When the mouse pointer becomes a cross, drag the pointer in the direction you want to move the camera. The pointer changes to a 
directional arrow, indicating the direction of the mouse. You can also use the PTZ OSD MENU to move the camera vertically and 
horizontally.

Figure 20. On-Screen PTZ Directional Arrows

6. Release the mouse button when you have repositioned the camera to the desired location. 
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7. To adjust the zoom, focus, and brightness, on the PTZ control:

• Zoom in or out: Click ZOOM PLUS (+) or ZOOM MINUS (–). 

• Focus: Click FOCUS PLUS (+) or FOCUS MINUS (–).

• Increase or decrease brightness: Click IRIS PLUS (+) or IRIS MINUS (–).

Figure 21. PTZ Control Toolbar with Camera Lens Controls

PTZ PRESETS
A preset is a user-defined camera configuration and position, which is set up using the PTZ controls and focus commands. The camera’s auto 
focus option must be turned off when configuring presets. Only cameras that support positioning and configuration using the Pelco D, Pelco P, or 
supported third-party protocols can use this feature. The DX4104 Series DVR can address up to 150 PTZ presets. Preset 95 is reserved for remote 
camera setup, and preset 99 is reserved for camera autoscan mode.

Configuring a Preset
The following PTZ operation guidelines apply:

• To program or clear presets, preset tours, and patterns, the Set button must be engaged; clicking the Set button places the DVR in 
PTZ programming mode. 

• While in PTZ configuration mode, multiple presets can be configured until the Set button is pressed again.

To configure a PTZ preset:

1. On the toolbar, click the Live icon .

2. On the View menu, point to OSD, and verify that PTZ check box is selected.

3. In the Client window, click a pane that displays PTZ . 

4. On the PTZ control, click Set .

5. To configure the preset location and camera settings:
a. Using the mouse, move the camera to the desired location.

b. On the PTZ control, click ZOOM, FOCUS, and IRIS to enter the camera settings.
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6. On the PTZ control:
a. Click the keypad and enter a number for the new preset.

b. Click Preset . The preset location and camera settings are stored in the camera’s memory.

7. Repeat steps 5 and 6 for each preset you want to configure.

8. Click Set to exit the configuration mode.

Activating a Preset
Double- and triple-digit presets can be set or activated by pressing the first and second digits sequentially. For example, preset 20 can be 
selected by clicking the number 2 and then 0 (zero) on the PTZ keypad. 

NOTE: To activate presets, tours, and patterns, the Set button must be deselected.

To activate a preset:

1. On the toolbar, click the Live icon .

2. In the Client window, click the PTZ-enabled pane. 

3. On the PTZ control keypad, click a number (1 to 150). 

4. Click Preset . The camera moves to the location configured for the preset.

Clearing a Preset
To clear a preset:

1. In the Client window, click the PTZ-enabled pane. 

2. On the PTZ control, click Set .

3. On the PTZ control keypad, click the number of the preset you want to clear.

4. Click Clear . The preset is deleted from the camera’s memory.

5. Repeat steps 3 and 4 to clear multiple presets.

6. Click Set to exit the configuration mode.

PRESET TOURS
A preset tour allows a camera to move through a configured sequence of PTZ presets. The DX4104 tour advances sequentially through presets 1 
to 16. The system pauses for approximately four seconds between the end of the current preset and the start of the next preset. If the presets are 
configured sequentially (1, 2, 3, 4, and so forth), the time period between presets is brief. If one or more the presets are not configured 
sequentially, the time period between presets can be longer because the system still accounts for the four-second interval for the non-configured 
preset memory location. For example, if presets 1 and 2 are configured and presets 3 to 16 are not configured, the system pauses approximately 
54 seconds before starting preset 1. 

A preset tour will operate continuously until another PTZ control action is performed. One or more presets must be configured to activate a preset 
tour. 

To activate a preset tour:

1. In the Client window, click the PTZ-enabled pane. 

2. On the PTZ control, click Preset . The preset tour starts.

To stop a preset tour:

1. In the Client window, click the PTZ-enabled pane.

2. On the PTZ control, click a button to initiate an action. For example, if you click ZOOM PLUS (+), the pattern stops.
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PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a specific beginning and end. Patterns are made up of a sequence of standard pan, tilt, 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra dome, connected to the DX4104. Once 
defined, a pattern can be activated with a series of on-screen commands. A pattern will run continuously until it is deactivated. Certain PTZ 
devices, such as Pelco’s Spectra Series domes, will display an on-screen message about the amount of remaining available memory.

Configuring a Pattern

To configure a pattern:

1. On the toolbar, click the Live icon .

2. In the Client window, click the PTZ-enabled pane. 

3. On the PTZ control, click Set .

4. On the PTZ control:
a. Click the keypad and enter a number for the new pattern (1 to 4).

b. Click Pattern . 

c. Using the mouse and PTZ control, move and configure the camera settings to create a pattern.

d. Click Pattern.

e. Click Set. The pattern is stored in the camera’s memory.

Activating and Clearing a Pattern
When activated, a pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

To activate a pattern:

1. On the PTZ control keypad, click 1 to 4.

2. Click Pattern. 

To stop a pattern:

1. In the Client window, click the PTZ-enabled pane.

2. On the PTZ control, click a button to initiate an action. For example, if you click ZOOM PLUS (+), the pattern stops.

To clear a pattern:

1. In the Client window, click the PTZ-enabled pane.

2. On the PTZ control, click Set.

3. On the PTZ control keypad, click 1 to 4.

4. Click Pattern.

5. Click Clear .

6. Click Pattern.

7. Click Set to exit the configuration mode.
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CONFIGURING A REMOTE CAMERA
You can access a camera’s configuration menu using the PTZ OSD Menu controls or the PTZ control.

Remote Camera Menu
To access the camera menu:

1. On the toolbar, click the Live icon .

2. In the Client window, click the PTZ-enabled pane. 

3. On the PTZ control, click Program . The camera menu appears. 

Figure 22. Camera Configuration Menu

For Pelco cameras, click Set, 9, 5, and then click Preset. The camera menu appears.

4. To access menu commands and settings:

• Move up and down through the camera menu/display settings:

– Click the PTZ OSD Menu up and down button (refer to PTZ Control on page 16 for more information). 

– Click FOCUS PLUS (+) and FOCUS MINUS (–).

• Make a menu a selection: Display a submenu or to move the cursor to the right, and then click IRIS PLUS (+).

• Cancel a menu selection: Cancel a selection or to move the cursor to the left, and then click IRIS MINUS (–).

• Exit the camera menu/setting: 

– Click IRIS MINUS (-) to select EXIT or to move the cursor to the left.

– Click IRIS PLUS (+) to exit the camera menu. 
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PLAYBACK VIDEO
Only users with administrator- and power-level permission can play back video. Video is played back one channel at a time. Refer to View Panes 
and Panels on page 14 for more information. 

RECORDED VIDEO AND AUDIO
The Client application allows you to play back recorded video and audio. Playing back video with audio has the following guidelines:

• In the Live mode, only one channel at a time can be played back.

• Your computer must be configured to play audio.

• The channel containing the video and audio must be selected.

PLAYBACK MODE
You can access the playback mode from the Live mode. Use the timeline to set the date and time for selecting recorded video for playback. 

The timeline is displayed in a 24-hour format. While in the Live mode, you can select the time by dragging the timeline pointer along the timeline. 
The recorded video status bar is displayed in the timeline indicating the type of recording (normal, alarm, or motion). Blank areas in the timeline 
indicate the absence of recorded video. Click the Increase Timeline Detail and Decrease Timeline Detail buttons to see the 24-hour timeline in 
increments of 5 minutes to 1 hour. 

Figure 23. Playback Timeline in 24-Hour View

When video is played back, the on-screen display for played back video includes the date and time fields, channel number, and remote site name.

Figure 24. Playback OSD
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To play back video:

1. On the toolbar, click the Live icon .

2. In the Client window, click a pane.

3. To select the playback date and time:
a. In the timeline Date box, select a date. The DX4104 displays (in blue) the days on which data was recorded.

.

Figure 25. Date Box

b. In the Time box, select a time. 

4. To start play back:

a. (Optional) To listen to recorded audio during playback, on the Playback control, click the Audio icon . 

NOTE: Your computer has to be configured for sound. 

Figure 26. Red Indicates Audio Playback is Disabled

b. On the Playback control, click the "Forward playback" button . 

c. On the Playback control, move the slider to the right to increase the volume.
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SAVING A SCREEN CAPTURE TO JPEG FORMAT
The “Save to JPEG” menu command allows you to capture video. The menu command is available when video playback is paused in the Playback 
or Search modes. The screen capture is saved in JPEG format to a location on the remote client PC hard drive. You can specify the location or 
accept the default path: C:\DX4100 Exported files.

1. (Optional) Create a destination folder if you want the JPEG files stored to a specific location.

2. On the toolbar, click the Live icon .

3. In the Client window, click a view pane.

4. To select the date and time, on the playback timeline:

5. To find a scene:

a. On the Playback control, click the "Forward playback" button .

b. Click Pause  when the video scene you want to capture appears. 

6. On the File menu, click “Save to JPEG.” The Export dialog box appears.

Figure 27. Export Dialog Box
C4632M (11/09) 37

Download from Www.Somanuals.com. All Manuals Search And Download.



7. To save the screen capture, perform one of the following options:

• Accept the default entries: Click Save. The screen capture is stored in JPEG format at the default location.

• Specify the path and file name: 

(1) In the Saved Path box, click Browse . The Export dialog box appears.

Figure 28. Export Dialog Box

(2) To go to the save path destination folder, click the folder, and then click OK. The save path appears in the Save Path box.

Figure 29. Saving a Screen Capture

(3) Accept the default file name displayed in the File Name box, or type a file name.

(4) Click Save. The file is saved to the designated destination.
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SEARCH WINDOW
The DX4104 supports the date/time, bookmark, and event search modes. Users must have administrator- or power-level permissions to search 
recorded video. 
.

Figure 30. Client Search Window

ì Date/Time: Allows you to search recorded video by date and time.

î Bookmark: Allows you to search video that was previously bookmarked at the DX4104 server. 

ï Event: Allows you to specify the date and time of an event search: all, motion, or alarm. 

ñ Search Control: Allows you to select a search mode.

ó Search Window: Allows you to access the search controls and view playback video.

r Playback Control Panel: Allows you to access the playback and audio controls. 

s Playback Timeline: Allows users with administrator- or power-level permissions to enter a date and time for playback.

t Date and Time: Allows you to playback video from a single camera or all cameras recorded at the time a specific event was detected. 

• Select All: When selected, allows you to playback video from multiple cameras. When deselected, allows you to play back video 
from the selected channel. This option must be deselected to play back video and audio.

• Device box: Displays the name of the selected search channel. 

• Date box and Time box: Allows you to enter the date and time.

u Site Tree: Allows you to view and select the site resources. 
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DATE/TIME SEARCH
The Date/Time search feature has the following guidelines:

• Playback timeline: Use the timeline calendar and time controls to specify the search criteria. 

• Searching for event-specific video: While in the Live or Search modes, drag the timeline pointer to a position in the timeline to initiate 
a search. The timeline provides a status bar that represents video recorded during the various recording modes (normal, alarm, and motion).

• Verifying the search device: To ensure that the proper camera channel is selected, check the camera information box above the 
playback timeline or verify that the desired view panel is framed with a thin red outline. 

• View format: The Date/Time search mode is supported in full-window view mode. 

• Select All: Allows you to search and playback video from all cameras. 

To search video by date and time:

1. On the toolbar, click the Search icon, . By default, the Search window appears in the Date/Time mode.

2. In the Client window, click a pane.

3. (Optional) Verify that Select All check box is selected.

4. Select the date and time on the playback timeline:
a. In the Date box, select a date.

b. In the Time box, select a time.

5. To start play back:

a. (Optional) To listen to recorded audio during playback, on the Playback control, click the Audio icon . 

b. On the Playback control, click the “Forward playback” button . 

DST DATE/TIME SEARCH AND PLAYBACK

If the unit is configured for daylight saving time (DST), the DVR uses a different approach to store and display video. When DST ends, the DVR’s 
internal time automatically adjusts backward one hour. Video is time-stamped and recorded one hour before and one hour after the time change. 
When DST begins, the DVR’s internal time automatically adjusts forward one hour and the unit records normally. 

The Date/Time search feature allows you to view video recorded before and after a DST time change (refer to Figure 31). For example, the DVR is 
configured for DST to end at 2:00 a.m. on November 1, 2009. The time period between column 01 and column 02 for channel 1 represents two 
recording periods: 

DST active (during  DST): Video recorded between 1:00 a.m. to 2:00 a.m.

DST ended (after DST): Video recorded between 1:00 a.m. to 2:00 a.m.

Figure 31. Video Recorded Before and After DST Changed

When you select a DST time period for playback, the DST dialog box appears (refer to Figure 32 on page 41). You are prompted to select a time 
period from which to play back video: "DST off" (after the time shifts back one hour) or "DST on" (before the time shifts back one hour). 
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To perform a DST Date/Time search:

1. On the toolbar, click the Search icon . 

2. In the Client window, click a pane.

3. (Optional) Verify that the Select All check box is selected.

4. To start playback:

a. (Optional) To listen to recorded audio during playback, on the Playback control, click the Audio icon .

b. Click the “Forward playback” button . The DST dialog box appears.

Figure 32. DST Dialog Box

c. In the DST box, select “DST on,” and then click OK.

5. To pause and resume playback or stop playback:

• Pause and resume playback: Click Pause , and then click Play.

• Stop playback: Click Stop . Playback stops. 

• Restart playback: To restart playback, repeat steps 5b and 5c.
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BOOKMARK SEARCH
Bookmark Search allows you to search video for a previously bookmarked camera on the DX4104 server. Refer to the DX4104 Server Operation/
Configuration manual for more information.

1. On the toolbar, click the Search icon .

2. Click the Bookmark icon . The Bookmark Search window appears.

3. In the Bookmark Search section, click Search. All bookmarked data is displayed in the Bookmark Search table. To stop a search in progress, 
click Cancel.

4. In the Bookmark Search section, click Search. All bookmarked data is displayed in the Bookmark Search table. To stop a search in progress, 
click Cancel.

5. To playback bookmarked video:
a. Click a search result. The snapshot of the video image is displayed in the view pane.

b. To view video, on the Playback control, click “Forward playback.”

Figure 33. Selecting Bookmarked Data for Playback

EVENT SEARCH
The Client Event Search feature allows you to search for event recorded video. The Event Search feature has the following guidelines:

• Event type: You can specify one of three event types: all (motion and alarm in), motion, or alarm in. 

• Time constraints: Date and time are specified as part of the search criteria. If an event occurred earlier than the specified date and time, 
the event is not found.

• Device: The event search returns results for one device.

1. On the toolbar, click Search.

2. Click Event. The Event search window appears.

3. In the Type box, select an event. 

4. In the Site Tree, click a camera. 

5. Click Search. All bookmarked data is displayed in the Bookmark Search table. To stop a search in progress, click Cancel.

6. To view video, click the Play Forward button .
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BACKUP SEARCH
Backup search allows you to locate and playback video that was backed up to a USB drive or to CD/DVD media. You can also copy the backed up 
data from the media to the Client PC’s hard drive. 

Select a Backup Media Device

NOTE: The backup location must contain backup files before the location can be added to the Backup Search dialog box. 

To add a location:

1. At the computer, connect or insert the backup media. The location is accessible. 

2. On the toolbar, click the Search button . By default, the Search window appears in the Date/Time mode.

3. On the File menu, click Backup Search. The Backup Search dialog box appears.

Figure 34. Backup Search Dialog Box

4. To add a backup location:

a. Click Add. The Add dialog box appears.

b. In the Name box, type a name for the location.

c. In the Open box, click the Browse button . The Open dialog box appears. 

d. Find the backup location, click the location/device, and then click OK. The path appears in the Add dialog box.
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5. Click OK. The location appears in the Backup Search dialog box. 

6. In the Backup Search table, select the backup location, and then click Update. 

7. Click OK. The backup media appears in Site Tree and the term "Backup" is displayed in each panes. 

Figure 35. Backup Search Window

Search Backup Media
You can view backed up video in any search mode. 

1. In the application window, click a pane. A red border highlights the selected camera pane. 

2. In the Search control, select a mode. 

3. Click Play . 

4. To hear recorded audio, on the Playback control, click the Audio icon . 

Exit Backup Search Mode

1. On the File menu, click End Backup Search. The unit returns to the local search mode.

2. To exit the search mode, on the toolbar, click the Live icon .
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EXPORT MODE 
Users must have administrator- or power-level permissions to export data. The export feature has the following guidelines:

• Export data types: Data is exported in either AVI or native format. AVI is the default format. 
– AVI: You must use a viewer such as a Windows Media® player to view this data. 
– Native: Use the DX4104 Export Viewer to view this data.

• DX4104 export time periods: There are five time periods to consider when exporting data:
– Standard time period: Data exported during a time not associated with the DST transition time frame.
– During DST: When exporting video for any duration between 01:00 and 01:59, the client application will prompt you to select a time 

period for DST On (first hour) or DST Off (second hour). The default selection is DST Off.
– Before and during DST: For example, if you select a time period of 00:58 to 01:15, the client application will export data 

beginning at 00:58, export data for the entire first hour (DST On), and export data for the second hour (DST Off) until 01:15. 
– During and after DST: For example, if you select a time period of 01:45 to 02:15, the client application will export data for the first 

hour (DST On) beginning at 01:45, export data for the entire second hour (DST Off), and then stop exporting standard data at 02:1 5.
– Incorporating both DST hours (DST On, DST Off): If you select a time period that includes the full DST time frame (for example, 

00:58 to 02:15), the client application will start the export process at 00:58, export the entire first and second hours (DST On and 
DST Off) from 01:00. to 01:59:59. Data exporting will stop at 02:15.

.

Figure 36. Client Export Mode

ì Server: Displays the name of the device for which data is being exported.

î Channel: Selects the export channel.

ï Audio: Allows audio data to be export.

ñ Date/Time: Configures the start/end date and time for exporting recorded video.

ó Save Path: Allows you to enter the location to store the exported data.

r Data Type: Supports exporting data in native or AVI format. 
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EXPORTING STANDARD DATA
To export standard data:

1. In the Site Tree, click a site.

2. On the toolbar, click the Export icon . 

3. To enter the export settings.
a. In the Server box, verify that the correct site appears. The Server box is unavailable, but the site name is visible.

b. In the Channel section, select the export channels (1 to 4). 

c. (Optional) To export audio data, in the Audio box, select On. 

4. To select a folder to store the exported schedule, perform one of the following options:

• Accept the default path: By default, the path is C:\DX4100 Exported files. Go to step 6.

• Enter a different path: 
(1) In the Windows environment, create a folder.

(2) In the Save Path box, click Browse . The Export dialog box appears.

(3) Go to folder, click the folder, and then click OK. The path appears in the Save Path box.

5. In the Data Type box, select a format.

6. Click Add. The entry appears in Export Setting table.

7. To export data: 
a. In the Export Setting table, select an entry. 

Figure 37. Export Dialog Box

b. Click Export. 

s Export Table Buttons: 
• Add: Populates the export table with the an export schedule.
• Edit: Allows you to modify an existing export schedule.

• Delete: Permanently removes the selected export schedule from the export table.

t Export Table: Displays the export entry. 

u Export controls: 
• Export: Starts the export process.
• Cancel: Stops the export process.
• Exit: Exits the Export mode. Exiting the Export mode does not stop or cancel an active export process.
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EXPORTING DATA RECORDED DURING DST
To export data recorded during DST:

1. In the Site Tree, click a site.

2. On the toolbar, click the Export icon . 

3. To enter the export settings, in the Export Setting section:
a. In the Server box, verify that the correct site appears. 

b. In the Channel section, select the export channels (1 to 4). 

c. (Optional) To export audio data, in the Audio box, select On.

4. To select the DST start date and time:
a. In the Start box, select the date, and then select the start time to be 01:00 or later.

b. In the End box, select the date, and then select the end time to be later than the start time, up to 01:59.

NOTE: The export duration is from 1 to 59 minutes within the one-hour DST time period.

Figure 38. Configuring the DST Date/Time Settings

5. To select a folder to store the exported schedule, perform one of the following options:

• Accept the default path: By default, the path is C:\DX4100 Exported files. Go to step 6.

• Enter a different path: 
(1) In the Windows environment, create a folder.

(2) In the Save Path box, click the Browse button . The Export dialog box appears.

(3) Click the folder, and then click OK. The path appears in the Save Path box.

6. In the Data Type box, select a format.

7. To select the DST export mode:

NOTE: The DST dialog box allows you to select the DST time period from which to export data. Refer to Exporting Data Recorded Before 
and After DST on page 50 for more information.

a. Click Add. The DST dialog box appears.

b. In the text box, select DST On, and then click OK. The export entry is added to the export table.

8. To export data: 
a. In the Export Setting table, select an entry. 

b. Click Export. 
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EXPORTING DATA RECORDED BEFORE AND DURING DST
To export data recorded before and during DST:

1. In the Site Tree, click a site. 

2. On the toolbar, click the Export icon . 

3. To enter the export settings, in the Export Setting section:
a. In the Server box, verify that the correct site appears. 

b. In the Channel section, select the export channels (1 to 4). 

c. (Optional) To export audio data, in the Audio box, select On.

4. To select the DST start date and time:
a. In the Start box, select the date, and then select the start time to be before 01:00.

b. In the End box, select the date, and then select the end time to be between 01:00 and 01:59.

5. To select a folder to store the exported schedule, do one of the following:

• Accept the default path: By default, the path is C:\DX4100 Exported files. Go to step 6.

• Enter a different path: 
(1) In the Windows environment, create a folder.

(2) In the Save Path box, click the Browse button . The Export dialog box appears.

(3) Click the folder, and then click OK. The path appears in the Save Path box.

6. In the Data Type box, select a format.

7. To select the DST export mode:
a. Click Add. The DST dialog box appears.

b. In the text box, select DST On, and then click OK. The export entry is added to the export table.

8. To export data: 
a. In the Export Setting table, select an entry. 

b. Click Export.
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EXPORTING DATA RECORDED DURING AND AFTER DST
To export data recorded during DST and after DST:

1. In the Site Tree, click a site.

2. On the toolbar, click the Export icon . 

3. To enter the export settings, in the Export Setting section:
a. In the Server box, verify that the correct site appears. 

b. In the Channel section, select the export channels (1 to 4). 

c. (Optional) To export audio data, in the Audio box, select On.

4. To set the start/end date and time:
a. In the Start box, select the date, and then select the start time to be between 01:00 and 01:59.

b. In the End box, select the date, and then select the end time to be later than 01:59.

5. To select a location for storing the exported schedule, perform one of the following options:

• Accept the default path: By default, the save path is C:\DX4100 Exported files. Go to step 6.

• Enter a different path: 
(1) In the Windows environment, create a folder.

(2) In the Save Path box, click the Browse button . The Export dialog box appears.

(3) Find the save path destination folder, click the folder, and then click OK. The save path appears in the Save Path box.

6. In the Data Type box, select a format.

7. To select the DST export mode:
a. Click Add. The DST dialog box appears.

b. In the text box, select DST On, and then click OK. The export entry is added to the export table.

8. To export data: 
a. In the Export Setting table, select an entry. 

b. Click Export.
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EXPORTING DATA RECORDED BEFORE AND AFTER DST
To export data recorded before and after DST:

1. In the Site Tree, click a site.

2. On the toolbar, click the Export icon . 

3. To enter the export settings, in the Export Setting section:
a. In the Server box, verify that the correct site appears. 

b. In the Channel section, select the export channels (1 to 4). 

c. (Optional) To export audio data, in the Audio box, select On.

4. To set the start/end date and time:
a. In the Start box, select the date, and then select the start time to be earlier than 01:00.

b. In the End box, select the date, and then select the end time to be later than 01:59.

5. To select a location for storing the exported schedule, perform one of the following options:

• Accept the default path: By default, the save path is C:\DX4100 Exported files. Go to step 6.

• Enter a different path: 
(1) In the Windows environment, create a folder.

(2) In the Save Path box, click the Browse button . The Export dialog box appears.

(3) Find the save path destination folder, click the folder, and then click OK. The save path appears in the Save Path box.

6. In the Data Type box, select a format.

7. To select the DST export mode:
a. Click Add. The DST dialog box appears.

b. In the text box, select DST On, and then click OK. The export entry is added to the export table.

8. To export data: 
a. In the Export Setting table, select an entry. 

b. Click Export.
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PRINTING
The print feature is available when playback is paused. The Client application allows you to select a pane and then print the displayed image. 
Printers must be configured before using the DX4104 client print feature.

To print an image:

1. On the toolbar, click the Live icon .

2. In the application window, click a view pane.

3. In the timeline, select a date and time.

4. On the Playback control, click Play . 

5. When the scene you want appears, on the Playback control, click Pause . The Print button becomes available.

6. To print the image:

a. On the toolbar, click the Print icon . The Print dialog box appears.

b. Choose the printer settings, and then click OK. The image prints.
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Configuration
The Client application Setup window allows you to configure the DX4104 server from a remote location. Only one user at a time with 
administrator-level permissions can access the Setup window. If two administrator-level users attempt to enter the Setup window 
simultaneously, the DX4104 will allow access on a first-come, first-served basis.

CAMERA PAGE
The Camera page contains the following features: 

• Channel: The DX4104 provides BNC inputs 1 to 4, corresponding to Camera 01 to Camera 04. 

• Covert: Allows a camera to be configured, viewed, and operated by users who are logged on with administrator-level permissions.

• Name: Allows you to create a unique name for each camera. The camera name must adhere to the following guidelines:
– Characters can include letters (a to z, upper and lowercase), numerals (0 to 9), and special characters.
– The camera name must not exceed 13 characters in length. 

• Audio: Associates the audio input (1 to 4) with a specified channel inputs 01 to 04.

• PTZ: Allows the PTZ settings to be configured at the server for each camera. Refer to PTZ Mode on page 54 for more information.
– Port: Allows you to assign a camera to a communication port: None, Data 1, or Data 2. 
– Address: Selects the camera’s address.
– Protocol: Selects the PTZ protocol used by the port. Multiple cameras assigned to a port must use the same protocol. Table G lists 

the supported third-party devices and the protocol used to operate the PTZ, focus, iris, and preset features.
– Baud Rate: Selects the baud rate for sending data to the camera. Available baud rates are as follows: 1200, 2400, 4800, 9600, and 

19200.

Table G. DX4104 Third-Party PTZ Compatibility 

Protocol Name Pan/Tilt Zoom Focus Iris Preset Tour Setup

LG_MULTIX Yes Yes Yes Yes Yes Yes Yes

LG_SD168 Yes Yes Yes Yes Yes Yes Yes

PELCO_D Yes Yes Yes Yes Yes Yes Yes

PELCO_P Yes Yes Yes Yes Yes Yes Yes

GANZ_DSCP Yes Yes Yes Yes Yes Yes Yes

GANZ_P360V1 Yes Yes Yes Yes Yes Yes No

KALATEL_CYBERDOME Yes Yes Yes Yes Yes Yes No

PANASONIC_CS850 Yes Yes Yes Yes Yes Yes Yes

SAMSUNG_SCC Yes Yes Yes Yes Yes Yes Yes

BOSCH_AUTODOME Unsupported at this time.

LG_ZOOM No Yes Yes Yes No No Yes

LPT_A100L Yes No No No No No No
52 C4632M (11/09)

Download from Www.Somanuals.com. All Manuals Search And Download.



• Motion: Allows you to preview the motion scene in a window, to configure the motion settings at the server and client for each camera. 
Refer to Motion Detection Setup on page 54 for more information.
– Sensitivity: Allows you to adjust motion sensitivity. Move the slider to the left to decrease the sensitivity; move the slider to the right 

to increase the sensitivity. 
– Relay out: Allows you assign the relay output to a camera. 
– Show Grid: Allows you to show or hide the motion grid.
– Set All: Selects all cells in the motion grid.
– Clear All: Clears all selected cells in the motion grid.

• Display: Allows you to configure the global display settings at the server. Refer to Display Setup on page 55 for more information.
– OSD: Selects the OSD language.
– Channel Name:  When selected, the channel name is displayed.
– Channel Status:  When selected, the channel status is displayed.
– Main Monitor: Allows you to select the dwell time in seconds (2, 5, 10, 20, 30, 40, 50, 60, 70, 80, or 90).
– Spot Monitor: Allows you to configure the dwell time in seconds (2, 5, 10, 20, 30, 40, 50, 60, 70, 80, or 90), Event Popup (Off, Alarm 

In, Motion, or All), and Spot Channel (Ch1, Ch2, Ch3, Ch4, Sequence 1, or Sequence 2).

Figure 39. Camera Page Options
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CAMERA CHANNEL
To set up each camera:

1. On the toolbar, click the Setup icon . The Setup window opens to the Camera page.

2. In Camera section, perform one of the following options:
a. In the Channel box, select a camera. 

b. (Optional) Click the Covert check box to select covert operation. 

c. In the Channel Name box, type a name.

d. In the Audio box, select an input.

3. To save the changes, click the Live icon , and then click OK.

PTZ MODE
PTZ devices are connected to the DX4104 using the DATA 1 and DATA 2 RS-485 ports located on the back of the unit. The unit supports up to four 
serial PTZ cameras. Multiple PTZ cameras are connected by daisy-chaining the camera connections. The DX4104 allows you to address and 
control multiple PTZ cameras individually.

PTZ camera control is achieved by using the respective protocol for that camera. Third-party device control is achieved by using the respective 
protocol for that camera, to operate the PTZ, focus, iris, and preset features. Refer to Table G on page 52 for more information.

To select a protocol:

1. On the toolbar, click the Setup icon . 

2. In the Protocol box, select a protocol.

3. To save changes, click the Live icon , and then click OK.

MOTION DETECTION SETUP
The motion detection window allows you to see the entire motion detection area. You can define one or more motion detection areas in the 
window.

The sensitivity control has the following guidelines:

• High sensitivity setting: A high motion level is needed before the DVR can detect motion and record the event.

• Low sensitivity setting: A low motion level will cause the DVR to detect and record video. 

• Medium 50% sensitivity setting (default): A typical motion level will cause the DVR to detect and record video.

To select a motion detection area:

1. On the toolbar, click the Setup icon . 

2. In the preview window, drag an area to the right. The dotted rectangle selection tool appears, and the selected area is highlighted green.

Figure 40. Motion Settings

To delete a motion area, right-click and drag to the right to select the area. You can also, click Clear All, which deletes all highlighted areas.
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3. To enter the motion sensitivity setting, perform one of the following options:

• Decrease sensitivity: Move the slider to the left.

• Increase sensitivity: Move the slider to the right. 

4. In the Relay Out box, select a setting. 

5. To save the changes, click the Live icon , and then click OK.

DISPLAY SETUP

NOTE: You select the Client OSD settings on the View menu.

The display setup has the following guidelines:

• OSD: 
– Language: Allows you to configure a specific language for each server. The server does not have to be restarted. 
– Channel name and channel status: Global server settings that show or hide the channel name and status indicators (recording 

mode icons).

• Main monitor: Global setting that allows you to set the dwell time. 

• Spot monitor: Global settings that allow you to select the dwell time, the event that will be displayed on the spot monitor, and the output 
channel for display.

To set up the OSD:

1. On the toolbar, click the Setup icon . 

2. In the Display section, select the display settings.

3. To save the changes, click the Live icon , and then click OK.
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SCHEDULE PAGE
The scheduling feature allows you to create daily, weekly, and holiday schedules. The unit supports single- or multi-event recording. Each camera 
is easily configured to record at a specific resolution, quality, and image rate when an event is triggered. The unit allows you to copy schedules 
between days, weekdays, and weekends. 

The Schedule feature has the following guidelines: 

• Schedule periods: Daily, weekly, and weekend.

• Recording modes: There are eight color-coded recording modes. The order of priority is instant, alarm, motion, and normal. The instant 
recording mode is only started at the DX4104 server.
– Single-event recording:

• No record (white): Video is displayed, but it is not recorded. 

• Normal (green): Video is recorded continuously over a 24-hour period. This mode uses the most hard disk storage.

• Alarm (red): Video is displayed, but it is not recorded until an alarm event is detected.

• Motion (blue): Video is displayed, but it is not recorded until a motion event is detected.
– Multi-event recording:

• A/M (alarm/motion, yellow): Video is only recorded if either an alarm or motion event is detected.

• N/A (normal/alarm, green and red): Video is recorded continuously in the normal mode. The unit records alarm video if an 
alarm event is detected. 

• N/M (normal/motion, green and blue): Video is recorded continuously in the normal mode. The unit records motion video if 
a motion event is detected. 

• N/A/M (normal/alarm/motion, green and yellow): Video is recorded continuously in the normal mode. The unit records 
alarm or motion video if the respective event is detected. 

• Schedule Copy: Allows you to copy a schedule from one day to another day, weekday (Monday to Friday), or weekend (Saturday and 
Sunday).

• Camera recording settings: Allows you to configure the following recording settings for the normal recording mode and the resolution, 
quality, and image rate for the alarm, motion, and instant recording mode. 
– Resolution: The default resolution is 352 x 240.

– Quality: Sets the picture quality of recorded video. Selections include lowest, low, standard, high, and highest.
– Image Rate: Sets the image rate. Refer to Table H for more information.
– Prealarm: Specifies the amount of time the DVR stores video that was recorded prior to the beginning of an alarm or motion event. 

Selections include OFF, 5, 10, 20, 30, 40, 50, and 60 seconds. 
– Postalarm: Specifies the amount of time that the DVR continues to record video after the alarm or motion event ends. Selections 

include 10, 20, 30, 40, or 50 seconds or 1, 2, 3, 5, or 10 minutes.

• Holiday schedule: Allows you to create up to 10 different holiday schedules. If a holiday schedule occurs on the same date as a weekday 
schedule, the holiday schedule will override the weekday schedule. 

Table H. Resolution and Image Rate

Resolution Image Rate

NTSC 352 x 240 1, 3, 5, 7.5, 15, 20, 30

704 x 240 1, 3, 5, 7.5, 15

704 x 480 1, 3, 5, 7.5

PAL 352 x 288 1, 3, 5, 6, 12.5, 20, 25

704 x 288 1, 3, 5, 6, 12.5 

704 x 576 1, 3, 5, 6
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DAILY RECORDING SCHEDULE 
To create a daily recording schedule:

1. On the toolbar, click the Setup icon . 

2. Click the Schedule icon . The Schedule page appears. By default, all daily schedules are configured for motion/alarm recording.

Figure 41. Schedule Page Options

3. In the Schedule section, select a day.

4. In the recording mode section:
a. Perform one of the following options:

• Single recording mode: Select a single recording mode: Normal, Alarm, or Motion.

• Multi-event recording mode: Select two or three recording modes Alarm/Motion, Normal/Alarm, Normal/Motion, or Normal/
Alarm/Motion. 

For example, click the Normal and Alarm check boxes, to configure Normal/Alarm multi-event recording (refer to Figure 41).

b. In the CAM section, click a camera time cell, and then drag the pointer to the right to select the time range (1 to 24 hours). The cells 
change color based on the recording mode selected in step 4a. 

Figure 42. Scheduled for Normal/Alarm Recording

c. Repeat steps 4a and 4b to schedule additional recording modes for the first camera. 
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5. Repeat step 4 to configure the recording modes for the remaining cameras.

6. To select the recording mode video settings (resolution, quality, and image rate): 
a. Click Recording. The Recording dialog box appears.

Figure 43. Recording Dialog Box

b. In the Resolution, Quality, Image Rate, Prealarm, and Postalarm box, select a setting for each channel.

c. Click OK. 

7. Repeat step 6 to configure video settings for the alarm, motion, and instant recording modes. 

8. To save the changes, click the Live icon , and then click OK.

COPYING SCHEDULES
The Client application allows you to copy a schedules as follows:

• A day of the week (Sunday to Saturday): The schedule for any day can be copied to another day, to the weekday, or to the weekend.

• Weekday (Monday to Friday): The schedule from the highlighted day is only copied to the respective channels for every day of the week 
except Saturday and Sunday.

• Weekend (Saturday and Sunday): The schedule from the highlighted day is copied to the respective channels for Saturday and Sunday.

NOTE: DX4104 server supports copying schedules between channels. The Client window allows you to view schedules created using this 
feature. 

1. On the toolbar, click the Setup icon . 

2. Click the Schedule icon . 

3. In the Schedule Copy section:
a. In the From box, select a day.

b. In the To box, select a setting. 

4. Click Copy. 

5. To save the changes, click the Live icon , and then click OK.
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HOLIDAY SCHEDULES
To create a holiday schedule:

1. On the toolbar, click the Setup icon . 

2. Click the Schedule icon . 

3. In the Holiday section, select the Holiday check box. The Holiday schedule appears. 

The Holiday Schedule grid and scheduling controls are displayed. By default, the holiday schedule is set to No Record. 

Figure 44. Holiday Schedule

4. In the Date box, select a date.

5. To select a name for the schedule, perform one of the following options:

• Create a name:
(1) Click the Name box, and then type a name.

(2) Click Add.

• Accept the name assigned by the system: Click Add. The system displays the entry in the Name list.

Figure 45. System Assigned Schedule Name
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6. To configure a recording schedule. 
a. In the Name list, click a schedule.

b. In the Schedule section, select a recording mode check box. 

c. Click a time cell, and then drag the pointer to the right to select the time range (1 to 24 hours). The cells change color based on the 
recording mode selected in at step 6a.

d. Repeat steps 6a to 6c to schedule additional recording modes for the first camera.

7. Repeat steps 6b to 3d to configure the recording modes for the remaining cameras.

8. To select the recording mode video settings (resolution, quality, image rate, and so forth): 
a. Click Recording. The Recording dialog box appears.

b. In the Resolution, Quality, Image Rate, Prealarm, and Postalarm box, select a setting for each channel.

c. Click OK. 

9. Repeat step 8a to 8c to configure video settings for the alarm, motion, and instant recording modes. 

10. To the save changes, click the Live icon , and then click OK.

DELETING A HOLIDAY OR SPECIAL DAY SCHEDULE

To delete a holiday or special day schedule:

1. On the toolbar, click the Setup icon . 

2. Click the Schedule icon . 

3. In the Holiday section, select the Holiday check box. The Holiday schedule appears.

4. In the Name list, click a schedule.

5. Click Delete. The selected schedule is deleted from the Name list.

6. To save the changes, click the Live icon , and then click OK.

To recover a deleted schedule:

1. On the DX4104 toolbar, click the Live icon . The “Configuration data has been changed. Save?” dialog box appears. 

2. Click Cancel and exit the Setup window. In this case, the changes are not saved. 

3. On the DX4104 toolbar, click the Setup icon . The Setup window appears.

4. Click the Schedule page icon . The Schedule page appears and the schedule that is to be deleted appears in the Name list.

WARNING: If you have not saved the changes after deleting a holiday or special day schedule, the deleted schedule can be recovered. 
If the changes are saved after deleting a schedule, the schedule cannot be recovered.
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LINKING PAGE
The linking setting allows you to configure the alarm relay for each camera.

• Alarm 01 to 04: Represents the alarm input.

• Input type: Alarms are configured for normally open (N.O.) or normally closed (N.C) inputs. 

• Camera: Allows you to select which camera (01 to 04, NONE) is linked to the alarm input. Multiple cameras can be linked to one alarm 
input.

• Relay output: Allows you to select the relay output state: on or off. 

• Relay off: Allows you to select how the relay output is turned off: 
– Alarm acknowledged:  Manually. The relay output must be turned off at the server.
– Post-alarm time: Automatically. The relay output is turned off based on the configured post-alarm time. 

• System alarm out: Enables or disables a system alarm output. 

ALARM INPUT SETUP

You can configure up to four alarm inputs and one relay output.

• One alarm input can be linked to one camera channel.

• Multiple alarm inputs can be assigned to one camera.

Figure 46. Linking Multiple Alarms to One Camera

• All alarm inputs are linked to one relay output.

To configure the alarm inputs:

1. On the toolbar, click Setup icon . 

2. Click the Linking icon . The Linking page appears. 

3. In the Event section, select the alarm linking settings for each camera. 

4. To save the changes, click the Live icon , and then click OK.
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NETWORK PAGE
The Client application allows you to configure certain network settings. You can view all of the network settings, but those settings that are 
unavailable must be configured on the DX4104 server. Refer to DX4104 Server Operation/Configuration manual for more information.

Figure 47. Network Page Options

TCP/IP BANDWIDTH TROTTLE SETUP

To set up the bandwidth throttle:

1. On the toolbar, click the Setup icon . 

2. Click the Network icon . The Network page appears.

3. In the Bandwidth Throttle box, select a setting. The default bandwidth throttle setting is 100 Mbps.

4. To save the changes, click the Live icon , and then click OK.

Table I. TCP/IP Ports Used by the DX4104 and Client Application

Port Number User Configurable Description

9002 Yes Base port for transmission of video, audio, and interface data

9003 Yes Software upgrades

9004 Yes Emergency agent notifications

9005 No Information port 

13900 No Ping port
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NOTIFICATION SETUP
The notification feature has the following guidelines:

• Alarm: Sends a text-based alarm notification in response to an alarm event. 

• Motion: Sends a text-based motion notification in response to a motion event.

• Disk full: Has the following guidelines based on the Hard Disk Overwrite setting at the server:
– ALL: A disk full notification is not sent, because the server does not issue a disk full warning. 

When the normal and event partitions are full, the DX4104 continues to record video by writing over previously recorded data (oldest 
recorded data is overwritten first). 

– OFF: Sends a disk full text-based notification in response to a normal or event partition disk full warning. 

When the hard drive is full (normal, event partition, or both), the system stops recording. 

– NORMAL: Sends a disk full text-based notification in response to a event partition disk full warning.

When the normal partition is full, the system continues to record by writing over previously record data in the normal partition. When 
the event partition is full, the system stops recording data to the event partition. 

– EVENT: Sends a disk full text-based notification in response to a normal partition disk full warning.

When the event partition is full, the system continues to record by writing over previously record data in the event partition. When the 
normal partition is full, the system stops recording data to the normal partition. 

• Admin password changed: Sends an administrator 01 ID notification in response to a change to the 01 ID administrator password.

Changing the password of additional users assigned administrator-level permission will not initiate a notification message.

• Video loss: Sends a video loss notification in response if video loss is detected on any channel. 

• Power on/off: Sends a power loss notification in response to the DX4104 power being turned off.

To configure the notification features:

1. On the toolbar, click the Setup icon . 

2. Click the Network icon . 

3. In the Notification section:
a. To select alarm indication, select the Alarm On check box. 

b. Repeat step 3a to enter the settings for the remaining notification check boxes.

4. To save the changes, click the Live icon , and then click OK.

DDNS SETUP
The Dynamic DNS (DDNS) feature uses port 8245 provided by No-IP™. If the DVR is installed in a network with a firewall, port 8245 has to be 
opened. The DX4104 supports the following DDNS services: 

• No-IP 

• DynDNS®

• zoneedit® 

• FreeDNS

To configure the DDNS service:

1. On the toolbar, click the Setup icon. 

2. Click the Network icon. 

3. In the DDNS section:
a. In the User ID box, type the user ID.

b. In the Password box, type the password.

c. In the Host Name box, type the host name.

4. To save the changes, click the Live icon, and then click OK.
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MAIL SETUP
The DX4104 mail feature sends an e-mail text notification to all designated users if an event is detected. The notification feature must also be 
configured. Refer to Notification Setup on page 63 for more information. 

NOTES: 

• The mail feature is configured and operates independently from the emergency agent feature. When configured, the emergency agent 
feature sends an emergency text report to the designated computer on which the Emergency Agent application is installed. Refer to 
Emergency Notification Setup on page 65 for more information.

• To use emergency e-mail notification, the DVR must be connected to a local area network (LAN) that maintains an simple mail transfer 
protocol (SMTP) mail server. The network must also be connected to either an intranet or the Internet, depending on the location of the e-
mail accounts to which you want to send notification. Consult your network administrator for information on configuring e-mail notification 
on your local network.

• The DX4104 supports SMTP-based e-mail clients: for example, Google Gmail™ is not supported.

The mail feature has the following guidelines:

• Notification: Turns the notification feature on and off.

• TLS: Select ON to use the Transport Layer Security (TLS) feature. By default, TLS is not enabled.

• SMTP Server: SMTP server IP address or host name. Supports up to 24 characters including 0.0.0.0 to 255.255.255.255, a to z, A to Z, 
numerals 0 to 9, and special characters.

• SMTP Port No: SMTP port. The default TCP/IP port used for SMTP is 25. Supported values are 25 and 1025 to 65535.

• User Name: Name of user to be notified. Supports up to 24 characters including 0.0.0.0 to 255.255.255.255, a to z, A to Z, numerals 0 to 9, 
and special characters.

• Password: User password. Supports up to 24 characters including a to z, A to Z, numerals 0 to 9, and special characters.

• Mail Address (1 to 3): User’s e-mail address. Supports up to 24 characters including a to z, A to Z, numerals 0 to 9, and special 
characters.

The SMTP server IP address, port number, user name, and password are optional settings. The DVR can send e-mail without using an SMTP 
server or message transfer agent (MTA). In certain cases, e-mail should be forwarded to a SMTP server.

To set up mail notification:

1. On the toolbar, click the Setup icon . 

2. Click the Network icon .

3. To select mail notification, in the Mail section:
a. Select the Notification check box.

b. In the SMTP Server box, type the serve user name.

c. (Optional) In the SMTP Port No. box, type the port number if it is not 25.

d. In the User Name box, type the user name where e-mail is to be sent.

e. In the Password box, type the password.

f. In the Mail Address1 box, type the e-mail address.

g. Repeat step 3f to for additional e-mail addresses. 

4. To save the changes, click the Live icon , and then click OK.
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EMERGENCY NOTIFICATION SETUP
The DX4104 Emergency Notification feature sends an emergency report to the designated computer on which the Emergency Agent application 
is installed. The Emergency Notification feature is configured and operates independently of the mail feature. Refer to Notification Setup on 
page 63 for more information. 

The Emergency Notification feature has the following guidelines:

• Notification: Turns the notification feature on and off.

• IP Address/Port: The remote computer’s IP address and port. Supported characters include 0.0.0.0 to 255.255.255.255.

• SMTP Port No.: The default port is 9003. Supported values include 025 to 65535.

To set up emergency notification:

1. On the toolbar, click the Setup icon . 

2. Click the Network icon .

3. In the Emergency section:
a. Select the Notification check box.

b. In the IP address/Port box, type the destination computer’s IP address.

c. Repeat step 3b for each additional computer.

4. To save the changes, click the Live icon , and then click OK.
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SYSTEM PAGE
The System page has the following guidelines:

• NTP: Selects that the unit’s time be synchronized with the Network Time Protocol (NTP) server.

• Date/Time: Allows you to select date and time format. 

• Server: Allows you select the NTP server.

• Sound: Allows you configure the unit to issue a sound in response to the following: 
– Button: Sounds a single beep when a front panel or remote control button is pressed. 
– Alarm:  Sounds a continuous beep approximately once per second until the alarm event is acknowledged. 
– Motion:  Sounds a continuous beep approximately once per second until the motion event is acknowledged. 
– System: Sounds a single beep when a system action occurs.

NOTE: Events are acknowledged at the DX4104 server. Refer to the DX4104 Server Operation/Configuration manual for more 
information.

• Update: Allows you to update the system software, PTZ protocols, and the update media.

• User: Allows you to create and administer user accounts. 

• Hard Disk: Allows you select the HDD overwrite method and set the full-warning setting.

• Log Out: Allows you to select the automatic user log off feature and time. 

Figure 48. System Page Options
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DATE AND TIME SETUP
The date and time feature has the following guidelines:

• NTP: Synchronizes the unit's time with the Network Time Protocol (NTP) server.

• Date/Time: The date and time displayed in the Client window is based on the date and time settings derived from and configured on the 
client computer. The server date and time cannot be configured from the Client application. Refer to the DX4104 Server Operation/
Configuration manual for more information. 

• Date Format: Allows you to select the date and time format. Refer to DX4104 Server Operation/Configuration manual for more 
information.

NOTE: When the date format is changed at the Client application, it becomes effective at the server after you enter and exit the server’s 
Setup menu. 

• Time Zone: Displays the time zone configured on the DX4104. 

• Server: Allows you to select a private or public server. For the public server, the DVR obtains the average time from five public servers 
(rime.nist.gov, time-a.nist.gov, timeb.nist.gov, ntp.nasa.gov, and clock.isc.org).

• Private Time Server: Allows you to enter the NTP server IP address or host name. Supports up to 24 characters including 0.0.0.0 to 
255.255.255.255, a to z, A to Z, numerals 0 to 9, and special characters.

• Sync. Interval: Allows you to select how often the DVR’s time is synchronized with the NTP server.

• Daylight Saving: Enables or disables daylight saving operation. You must configure DST on both the DX4104 and the computer on which 
the remote Client application is running. 
– Start: Sets the start time. The effective time is 2:00 a.m.
– End: Sets the end time. The effective time is 2:00 a.m.

To configure the date and time settings:

1. On the toolbar, click the Setup icon . 

2. Click the System icon . The System page appears.

3. In the Date/Time section:
a. (Optional) select the NTP check box. 

b. In the Date Format box, select the date format.

NOTE: The time zone setting is displayed but is unavailable. This setting must be configured on the DX4104 server. Refer to the 
DX4104 Server Operation/Configuration manual for more information.

c. In the Server box, perform one of the following options:

• Accept the default server setting: Go to step 3d.

• Enter a private time server: In the Private Time Server box, type the server’s IP address or host name. 

d. In the Sync. Interval box, select an interval. 

e. (Optional) Select the DST start and end dates.

4. To save the changes, click the Live icon , and then click OK.
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SOUND SETUP

To configure the sound feature:

1. On the toolbar, click the Setup icon . 

2. Click the System icon . 

3. In the Sound section:
a. To select the button sound feature, select the Button check box. 

b. Repeat step 3a to enter the settings for the remaining sound check boxes.

4. To save the changes, click the Live icon , and then click OK.

UPDATE SOFTWARE SETUP

The update feature has the following guidelines:

• Selection: Allows you to select to update the server software and PTZ protocols.

• Method: Allows you to select the update media.

• Update Server: Allows you to enter the update server’s IP address. This setting becomes available if the update method is set to 
Network.

To configure the update feature: 

1. On the toolbar, click the Setup icon. 

2. Click the System icon. 

3. In the Update section:
a. In the Selection box, select the update process.

b. In the Method box, select the update device

c. (Optional) In the Update Server box, type the update server IP address.

4. To save the changes, click the Live icon , and then click OK.
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USER ACCOUNT SETUP
User accounts can be added, changed, or deleted. By default, both the user name and password is admin, admin.

• User ID: Allows you to create user accounts. 

The user name has the following guidelines:

• Characters can include letters (a to z, upper and lowercase), numerals (0 to 9), and special characters.

• The user name must not exceed 23 characters in length. 

• Level: Allows you to create three user levels: Administrator, Power User, and Normal User. A user is assigned a level when the user 
account is created. Table J describes the user levels and permissions granted to each level.

• Password: Allows you to administer the user account password. 

If you change the password, it must adhere to the following guidelines:

• Characters can include letters (a to z, upper and lowercase), numerals (0 to 9), and special characters.

• The password must contain 4 to 8 characters. 

The DX4104 supports 10 user accounts including the default administrator account. 

Table J. User Levels and Permissions

DVR Operation
User Level

Administrator Power User Normal User

Live Yes Yes Yes

Search Yes Yes No

PTZ Yes Yes Yes

Alarm Off Yes Yes Yes

Instant Playback Yes Yes Yes

Instant Record Yes Yes Yes

Instant Backup Yes Yes No

Select Display Mode Yes Yes Yes

View System Log Yes Yes Yes

View System Information Yes Yes Yes

Setup Yes No No

Export Yes Yes No
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Changing the Administrator User Password
To change the administrator password:

1. On the toolbar, click the Setup icon . 

2. Click the System icon . 

3. In the User section:
a. In the User ID list, select admin, and then click Edit. The Password Confirm dialog box appears.

Figure 49. Selecting the Administrator-Level User

b. In the Password box, type the current administrator password, and then click OK. If the password is correct, the User Setting dialog 
box appears. 

c. In the User Settings dialog box, perform one of the following options:
(1) In the Password box, type a new password.

(2) In the Confirm Password box, retype the new password.

(3) Click OK. The administrator password is changed. If the DVR is configured for e-mail notification, a message is sent to the 
designated user that the password has been changed.

4. To save the changes, click the Live icon , and then click OK.

Adding a New User
To create a new user:

1. On the toolbar, click the Setup icon. 

2. Click the System icon. 

3. In the User section, click Add. The User Setting dialog box appears.

4. In the User Setting dialog box:
a. In the User ID box, type a user ID.

b. In the Password box, type a password.

c. In the Confirm Password box, retype the password.

d. In the Level box, select a user level.

e. Click OK. The user ID and permission level appears in the User ID list.

5. To save the changes, click the Live icon , and then click OK.
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Changing a User Account
To change an account: 

1. On the toolbar, click the Setup icon . 

2. Click the System icon . 

3. In the User ID list, select a user ID, and then click Edit. The User Setting dialog box appears.

4. In the User Settings dialog box:
a. In the User ID box, type a new user ID.

b. In the Password box, type a new password.

c. In the Confirm Password box, retype the password.

d. In the Level box, select a different user level.

e. Click OK. The updated user ID and permission level appears in the User ID list.

5. To save the changes, click the Live icon , and then click OK.

Deleting a User
1. On the toolbar, click the Setup icon. 

2. Click the System icon. 

3. In the User ID list, select a user ID, and then click Delete. The user ID is removed from the User ID list.

4. To save the changes, click the Live icon , and then click OK.

HARD DISK STORAGE ALLOCATION SETUP
You can remotely configure the DX4104 server overwrite and full warning features. The event partition setting is unavailable and is configured 
directly at the server.

The Hard Disk feature has the following guidelines: 

• Overwrite: 
– ALL: When the normal and event partitions are full, the system will begin overwriting those partitions. The oldest recorded data is 

overwritten first. The default setting is ALL. 
– NORMAL PARTITION: When the normal partition is full, the system will begin overwriting only the normal partition. The oldest 

recorded data is overwritten first.
– EVENT PARTITION: When the event partition is full, the system will begin overwriting only the event partition. The oldest recorded 

data is overwritten first.
– OFF: Protects all partitions from being overwritten.

• Full Warning: Displays a warning message when the HDD has reached the configured percentage (size) capacity. The default setting is 
70 percent.

• Event Partition: Specifies the percentage (size) of the total hard disk space allocated for storing event-related recorded video. 
The remaining disk space is allocated for storing instant recorded video and normal recorded video. This option cannot be configured 
remotely using the Client application. 

WARNING:  If you change the event partition setting at the server, the system will reformat all of the hard drives. All recorded video will 
be erased. 
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Emergency Agent
The Emergency Agent works with networked DVRs to alert you when an event has occurred. The Emergency Agent has the following guidelines: 

• Emergency events detected: Alarm, motion, disk full, administrator password change, video loss, and power on/off. 

• Configuration required: 
– DX4104 server: The schedule (event recording mode), network notification (event to be monitored), and emergency settings must be 

configured on each DVR for which you want to monitor. Refer to the DX4104 Server Operation/Configuration manual for more 
information.

– Remote computer: The Emergency Agent must be running and configured to receive emergency notifications. 

EMERGENCY AGENT WINDOW

Figure 50. Received Messages Window

ì Event Report List: Displays event reports. 

î Message Area: Displays details about the selected event. 

ï CLOSE: Closes the received Messages window, but does not exit the Emergency Agent application.

ñ DELETE: Permanently deletes the selected event. 

ó REFRESH: Updates the entries. 

r SEARCH: Opens the Message Search dialog box that allows you to search for a specific event. 

s PORT: Opens the Option dialog box that allows you to verify or change the port number.
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STARTING AND STOPPING

STARTING THE EMERGENCY AGENT

To start the Emergency Agent, click the Start button, and then point to All Programs, Pelco, PELCO DX4100 Client, and then click DX4100 
Emergency Agent.

The Emergency Agent application starts and the Pelco logo appears in the Windows task bar.

Figure 51. Starting the Emergency Agent

To open the Emergency Agent menu, on the Windows task bar, right-click Pelco . The Emergency Agent menu appears. 

Figure 52. Emergency Agent Menu

STOPPING THE EMERGENCY AGENT
NOTE: To ensure that the Emergency Agent monitoring events, verify that Pelco is displayed in the Windows task bar.

To stop the Emergency Agent:

1. On the Windows task bar, right-click Pelco. The Emergency Agent menu appears. 

2. Click Exit.

EVENT MONITORING
An event warning sent from the DVR server cause a 5-second message to appear in the lower-right corner of the remote computer screen.

Figure 53. Emergency Agent Message
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VIEWING MESSAGE DETAILS

To view details about an event: 

1. Do one of the following:

• Message: Within 5 seconds, click the message. The Received Message window appears. The event appears in the event report list.

• Emergency Agent menu: 

(1) On the Windows task bar, click Pelco . 

(2) On the Emergency Agent menu, click Check Message Box. The Received Message window appears.

2. Click a message. Details about the event appears in the message area.

Figure 54. Viewing Event Message Details

SEARCHING FOR AN EVENT

To search for a logged event:

1. On the Windows task bar, click Pelco . 

2. On the Emergency Agent menu, click Check Message Box. 

3. On the Received Messages toolbar, click Search . The Message Search dialog box appears.

Figure 55. Selecting Event Type Search Settings
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4. To select the search method (refer to Figure 55), do one or both of the following:

• Search by event:
(1) Select Event Search check box. The Event check boxes become available.

(2) In the Event section, select the event’s check box.

• Search by date:
(1) Select the Date Search check box. The Date check boxes become available. The start date is the top box and the end date is the 

bottom box.

(2) In the Date section, select start and end date.

5. Click Search. The logged events appear in the Received Messages window.

DELETING AN EVENT REPORT
1. In the Received Messages window, click an entry.

2. Click DELETE. The DvrEA dialog box appears.

3. Click Yes to permanently delete the entry. 

4. In the Received Messages window, click CLOSE. The Received Messages window closes, but the Emergency Agent application is still 
active.

SELECTING THE LANGUAGE

1. On the Windows task bar, click Pelco . 

2. On the Emergency Agent menu, point to language, and then click a language.

CONFIGURING THE NETWORK PORT
To change the network port:

1. On the Windows task bar, click Pelco. 

2. On the Emergency Agent menu, click Check Message Box. The Received Messages window appears.

3. In the Received Messages window, click Port . The Option dialog box appears. 

4. In the Emergency Agent Port No. box, type a new port number. The default port number is 9002.

NOTE: You should keep the default port setting unless there is a conflict on your network. Consult your network administrator before 
changing network port settings. If the port number must be changed, the number must be an integer between 1025 to 65535. 

5. Click OK.
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DX4104 Export Viewer
The Export Viewer allows you to play back video that is exported from the DX4104 server. You can verify the digital watermark embedded in 
DX4104 native video. Watermarking is used to authenticate the originality of a video file and to alert users to possible image tampering. The 
DX4100 Export Viewer application runs automatically each time a CD/DVD created by the DX4104’s export feature is inserted into a 
Windows-based personal computer (PC). The software can also be installed on a PC and opened independently, when necessary. 

The USB mouse is used to access Export Viewer GUI controls and features. Menu commands can be selected with the mouse, or you can press 
Alt + C to select the command.

NOTE: When video recorded on a DX4104 server located in one time zone (for example, GMT -8:00) is exported and played back on a computer 
located in a different time zone (for example, GMT -5:00), the video's original recording time is adjusted to and displayed based on the time zone 
of the playback computer. 

DX4100 EXPORT VIEWER WINDOW

Figure 56. Export Viewer Window

ì Set Watermark ï Playback Slider

î Playback Controls
 Play
 Stop
 Fast Forward to End

 Pause
 Fast Reverse to Beginning

ñ View Panel

ó Menu Bar

r Video Information Section
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STARTING AND STOPPING

STARTING THE EXPORT VIEWER

To start the Export Viewer, click the Start button, point to All Programs, Pelco, PELCO DX4100 Client, and then click DX4100 Export Viewer.

STOPPING THE EXPORT VIEWER

To exit the Export Viewer application, on the File menu, click Exit.

EXPORTED VIDEO FILE NAMING CONVENTION
The DX4104 exported video file name contains details about the exported video. 

Figure 57. Exported Video File Naming Convention 

VIEWING EXPORTED VIDEO
The DX4104 exports video to USB media and CD/DVD +RW media. 

To view exported video: 

1. Perform one of the following options.

• USB media: 
(1) Insert the USB drive into the computer.

(2) Click the Start button, and then point to All Programs, Pelco, PELCO DX4100 Client, and then click DX4100 Export Viewer. The 
DX4104 Export Viewer application window appears. 

• CD/DVD media:
(1) Insert the CD/DVD disc. The Export Viewer application starts automatically.

2. On the File menu, click Open. The Open dialog box appears.

3. In the “Look in” box, select device, and then select the export file.

4. Click Open. The file opens in the DX4104 Export Viewer window.

5. To view video, on the Control, click Play .

ì Channel/Camera Number

î Date of Recorded Video

ï Time of Recorded Video

ñ Pelco-Engineered Video Format
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VERIFYING THE WATERMARK
Watermarking is used to authenticate the originality of a video file and to alert users to possible image tampering. The Export Viewer will display 
a message if the video image has been altered.

Figure 58. Altered Video Message

To verify the watermark:

1. In the Option section, select the “Set Watermark” check box. 

2. Open the exported file for which you want to verify the watermark. Playback starts. The Export Viewer performs a check to authenticate the 
watermark. If the watermark is authentic, no action is taken. If the video image has been altered, the Export Viewer displays the INFO 
dialog box.

CHANGING THE LANGUAGE
To change the language, on the Lang (L), select a language. The Export Viewer GUI changes to the selected language.
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Web Client
The DX4104 Web Client allows you to view live video, operate the PTZ features of cameras attached to DX4104 Series DVRs, and capture video 
displayed in the view panel. Using a standard Web browser, you can remotely monitor up to 16 cameras for up to 16 DX4104 servers 
simultaneously. 

Web client features include:

• Live viewing of up to 16 cameras simultaneously

• Ability to monitor cameras from multiple DX4104 sites

• Multiple screen division options including one, four, and sixteen panel views

• Full PTZ control

• Runs on multiple platforms using a standard Web browser

• Capture video displayed in the view panel and save the file to disk

NOTE: The DX4104 Web Client is only compatible with Internet Explorer®.

INSTALLING THE WEB CLIENT
The first time you use a Web browser to connect to a DVR server, an ActiveX® control application is downloaded and installed on your local 
computer. This control facilitates usage of the Web client’s interactive features.

1. Start Internet Explorer.

2. In the browser Address bar, type the DX4104 server IP address.

3. Click Go. The ActiveX installation message appears. 

4. Click the ActiveX installation message. The submenu appears. 

Figure 59. ActiveX Submenu

5. Click Install ActiveX Control. The Security Warning dialog box appears.

Figure 60. Security Warning Dialog Box

6. Click Install. Wait while the ActiveX controls are downloaded to your PC and your browser software is updated. The Remote Login dialog 
box appears. 
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Web Client Window

Figure 61. Web Client Application Window

ì Site Tree: Displays top-down, hierarchical management of DX4104 resources, such as servers, 
cameras, alarms, and relays.

î Display Options: Displays video in one or four panes.

ï Cycle View: Starts and stops the window cycling.

ñ Full Screen: Hides the GUI controls and displays video across the entire screen. Click the right mouse 
button to exit the full-screen display.

ó Snapshot: Captures the video image displayed in the view pane.

r PTZ ZOOM: Zooms the camera in and out.

s PTZ FOCUS:

• In PTZ mode: Adjusts the camera focus.

• In the camera menu: FOCUS plus (+) and FOCUS minus (–) are used to navigate up and down in the 
camera menu.

t PTZ IRIS:

• In PTZ mode: Opens and closes the camera iris.

• In the camera menu: IRIS plus (+) selects an item. IRIS minus (–) exits an option setting; in the 
camera menu, it moves the cursor to EXIT.

u PTZ Keypad: Use the keypad to enter presets or pattern numbers.

~í PTZ OSD MENU: Allows users to operate the PTZ OSD features.

~â View Pane: Displays video from a single camera channel.
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STARTING AND LOGGING ON
To start the DX4104 Web Client, cookies must not be blocked by your browser. Refer to the Internet Explorer Help for instructions on enabling 
cookies. User names and passwords are case sensitive; type them exactly as shown.

NOTES: To avoid potential problems and conflicts with your computer’s video subsystem, run only one instance of the Client application or Web 
Client at a time.

To start and log on to the Web Client:

1. Start Internet Explorer.

2. In the browser Address bar, type the DX4104 server IP address. The Web Client window and the Remote Login dialog box appear.

3. In the User Name and Password box, type the user name and password, and then click OK.

LOGGING OFF AND STOPPING
To log off and exit from a remote site:

1. In the Site Tree, right-click a site. The shortcut menu opens. 

2. In the shortcut menu, click User Log-Out. 

3. To exit the Web Client window, click Close.

VIEWING VIDEO
For viewing live video and operating PTZ cameras, refer to PTZ Mode on page 30. Some of the features shown in the Operation on page 22 
section may not be available in the Web Client.

CONFIGURING VIEW PANELS
The DX4104 Web Client can display up to 4 cameras simultaneously. The following table describes the toolbar.

Table K. Web Client Toolbar

1-Division: Displays video from one camera.

4-Division: Displays video from four cameras simultaneously.

9-Division: Unavailable.

16-Division: Unavailable.

6-Division: Unavailable.

8-Division: Unavailable.

Cycle Views: Turns the window cycling feature on and off when in the single-pane display mode. 

Full Screen: Displays video from one camera, expanding the application window to occupy the entire screen. Click the right 
mouse button to exit full-screen view. 

Video Capture: Initiates a screen capture of the current view panel. The file is automatically named (using the 
YYYYMMDD_hhmmss format) and stored in JPEG format at C:\DX4104 (default location).
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Appendix

HARDWARE AND SOFTWARE UPGRADE POLICY 
Pelco’s representations regarding product features and performance are limited to those made in the specification sheet and installation/
operation manuals at the time the product was manufactured. Pelco does not represent or warrant that any upgrades to product hardware or 
software will be made available in the future. When possible, Pelco will offer product upgrades to purchasers of its products. 

HARDWARE UPGRADES
Pelco provides hardware options for upgrading the DX4104 hard disk storage and optical drive. For information about DX4104 upgrade options, 
refer to the DX4104 product specification sheet. Hard disk upgrades are available as follows:

1. Additional hard drives or an optical drive cannot be installed in some models. To determine if your model can be upgraded, refer to the 
DX4104 Installation manual or contact Pelco Product Support for assistance.

2. Hard disk upgrades are available through Pelco at established prices and are subject to the usual 24-hour turnaround for service.

When a larger hard drive is being substituted for a smaller one, the smaller drive will be returned to the customer along with the upgraded unit.

While Pelco will perform all upgrades with the utmost consideration and care, Pelco cannot guarantee that any of the data and/or video stored 
on the existing hard drives will not be lost or damaged. Pelco is not responsible for damage or loss of data.

SOFTWARE UPGRADES
1. All upgrades for Pelco software shall be free to the customer for the duration of the warranty period. This offer does not apply to software 

that may be installed in a Pelco product that is licensed from another supplier. All other software, such as operating systems, drivers for 
accessory devices, and so forth, shall be governed by the software manufacturer’s upgrade policy, even when said upgrades are necessary 
to implement an upgraded version of Pelco software.

2. Whenever possible, software upgrades with detailed instructions shall be provided to the customer through Web site download. Pelco will 
not be responsible for loss of data, losses due to downtime, or damage to product as a result of a customer attempting to perform an 
upgrade.

3. Hard copies on appropriate medium (CD/DVD, ZIP, or floppy disk) shall be sent to the customer at no charge upon request.

4. It shall be the customer’s responsibility to procure necessary hardware to perform upgrades if required (necessary drives, such as CD-R, 
DVD-R, or ZIP).

5. Pelco cannot guarantee that all future software versions will be backward compatible with earlier hardware platforms.
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PRODUCT WARRANTY AND RETURN INFORMATION

WARRANTY
Pelco will repair or replace, without charge, any merchandise proved defective in
material or workmanship for a period of one year after the date of shipment.

Exceptions to this warranty are as noted below:
• Five years:

– Fiber optic products
– Unshielded Twisted Pair (UTP) transmission products
– CC3701H-2, CC3701H-2X, CC3751H-2, CC3651H-2X, MC3651H-2, and

MC3651H-2X camera models
• Three years:

– Pelco-designed fixed network cameras and network dome cameras with
Sarix™ technology.

– Pelco-branded fixed camera models (CCC1390H Series, C10DN Series,
C10CH Series, and IP3701H Series)

– EH1500 Series enclosures
– Spectra® IV products (including Spectra IV IP)
– Camclosure® Series (IS, ICS, IP) integrated camera systems
– DX Series digital video recorders, DVR5100 Series digital video recorders,

Digital Sentry® Series hardware products, DVX Series digital video
recorders, and NVR300 Series network video recorders

– Endura® Series distributed network-based video products
– Genex® Series products (multiplexers, server, and keyboard)
– PMCL200/300/400 Series LCD monitors

• Two years:
– Standard varifocal, fixed focal, and motorized zoom lenses
– DF5/DF8 Series fixed dome products
– Legacy® Series integrated positioning systems
– Spectra III™, Spectra Mini, Spectra Mini IP, Esprit®, ExSite®, and PS20

scanners, including when used in continuous motion applications.
– Esprit Ti and TI2500 Series thermal imaging products
– Esprit and WW5700 Series window wiper (excluding wiper blades).
– CM6700/CM6800/CM9700 Series matrix
– Digital Light Processing (DLP®) displays (except lamp and color wheel). The

lamp and color wheel will be covered for a period of 90 days. The air filter is
not covered under warranty.

– Intelli-M® eIDC controllers
– PMCL542F, PMCL547F, and PMCL552F FHD monitors

• One year:
– Video cassette recorders (VCRs), except video heads. Video heads will be

covered for a period of six months.

• Six months:
– All pan and tilts, scanners, or preset lenses used in continuous motion

applications (preset scan, tour, and auto scan modes).
Pelco will warrant all replacement parts and repairs for 90 days from the date of
Pelco shipment. All goods requiring warranty repair shall be sent freight prepaid
to a Pelco designated location. Repairs made necessary by reason of misuse,
alteration, normal wear, or accident are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss
resulting from the specific use or application made of the Products. Pelco’s liability
for any claim, whether based on breach of contract, negligence, infringement of
any rights of any party or product liability, relating to the Products shall not exceed
the price paid by the Dealer to Pelco for such Products. In no event will Pelco be
liable for any special, incidental, or consequential damages (including loss of use,
loss of profit, and claims of third parties) however caused, whether by the
negligence of Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may
also have additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the
following information:

1. Model and serial number
2. Date of shipment, P.O. number, sales order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product that does not fall under
the warranty conditions stated above, please include a written explanation with
the product when returned.

Method of return shipment shall be the same or equal to the method by which the
item was received by Pelco.

RETURNS
To expedite parts returned for repair or credit, please call Pelco at (800) 289-9100
or (559) 292-1981 to obtain an authorization number (CA number if returned for
credit, and RA number if returned for repair) and designated return location.

All merchandise returned for credit may be subject to a 20 percent restocking and
refurbishing charge.

Goods returned for repair or credit should be clearly identified with the assigned
CA or RA number and freight should be prepaid.

The materials used in the manufacture of this document and its components are compliant to the requirements of Directive 2002/95/EC.

This equipment contains electrical or electronic components that must be recycled properly to comply with Directive 2002/96/EC of the European Union 
regarding the disposal of waste electrical and electronic equipment (WEEE). Contact your local dealer for procedures for recycling this equipment.
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